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LEGAL NOTICES 

IRISConnect-dgi-pko-06032012-07 

Copyrights 

Copyrights ©2011-2012 I.R.I.S. All Rights Reserved. 

I.R.I.S. owns the copyrights to the IRISConnect software and to this 

publication. 

The information contained in this document is the property of 

I.R.I.S. Its content is subject to change without notice and does not 

represent a commitment on the part of I.R.I.S. The software 

described in this document is furnished under a license agreement 

which states the terms for use of this product. The software may be 

used or copied only in accordance with the terms of that agreement. 

No part of this publication may be reproduced, transmitted, stored 

in a retrieval system, or translated into another language without the 

prior written consent of I.R.I.S. 

 

Trademarks 

The I.R.I.S. logo, IRISConnect, IRISPowerscan, IRISDocument 

Server, IRISCapture Pro, IRISXtract for Documents and IRISNext 

are trademarks of I.R.I.S. 

OCR ("Optical Character Recognition"), Linguistic technology, 

ICR ("Intelligent Character Recognition") technology, MICR 

("Magnetic Ink Character Recognition") technology, BCR ("Bar 

Code Reading") technology, and iHQC ("intelligent High Quality 

Compression) technology by I.R.I.S. 
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All other products mentioned in this publication are trademarks or 

registered trademarks of their respective owners. 
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INTRODUCING IRISCONNECT 

WHAT IS IRISCONNECT 

IRISConnect is a singular and stand-alone framework to connect 

any I.R.I.S. solution to a wide range of third-party ECM and CRM 

systems, both in a private intranet environment and in the Cloud. 

IRISConnect allows you to export the documents you process with 

your I.R.I.S. solutions – including the indexes you assign to them – 

to the destination of your choice. 

IRISConnect can also be developed to work with third-party 

document processing solutions. 

IRISConnect currently connects to the following systems, via 

specific connectors and generic connectors. 

Specific Connectors Generic Connectors 

ECM Systems Cloud Systems  

Therefore Therefore Online ODBC 

SharePoint SharePoint Online Toolbox 

(Examples: Microsoft Dynamics, 

Sage, SAP) 

FileNet EverNote CMIS 

(Examples: Documentum, 

Alfresco, Nuxeo, Sensenet) 

IRISNext Dropbox  

 Box  
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GoogleDocs 

Note that all connectors are built around the same backbone. In 

other words, if you know how to configure 1 connector, you know 

how to configure them all. 

Also, when you acquire one connector – IRISConnect for Therefore 

for instance – you will be able to use it combined with every 

supported I.R.I.S. solution. 

The Cloud systems Box, Dropbox, Evernote and GoogleDocs are 

bundled in one license package called IRISConnect for Cloud. 

Note that the generic connectors allow you to do a more advanced 

configuration, for instance to export documents to an ERP system in 

the case of IRISConnect Toolbox. Dedicated Technical Notes are 

available for IRISConnect Toolbox and IRISConnect for ODBC. 

USING IRISCONNECT 

IRISConnect can be used in different ways: 

 IRISConnect combined with I.R.I.S. solutions as input source 

 IRISConnect combined with third-party applications as input 

source 

 IRISConnect as stand-alone application* 

IRISConnect combined with I.R.I.S. solutions as 

input source 

The following I.R.I.S. scanning and document management 

solutions offer an integrated connection with IRISConnect: 
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 IRISPowerscan 9.6 and higher 

 IRISDocument Server 9.5.0.2 and higher 

 IRISCapture Pro 8.51 and higher 

 IRISXtract for Documents 3.2 and higher 

 Readiris 14 and higher 

 IRISNext 7.4 and higher 

The level of integration currently varies from one I.R.I.S. solution 

to another. IRISPowerscan for instance offers convenient 

Configuration Wizards, while in IRISDocument Server there are a 

few more manual configurations to be done. 

The procedures on how to configure IRISConnect combined with 

these I.R.I.S. solutions – except Readiris* – are explained in this 

manual.  

*Readiris isn’t included in this manual since the connectors are an 

integral part of the Readiris software and no IRISConnect license is 

required to use the connectors in Readiris. 

IRISConnect combined with third-party applications 

as input source 

IRISConnect can be integrated in any third-party application. 

Refer to the separate Developer Guide to learn how to do so. 

IRISConnect as stand-alone application* 

Note that IRISConnect can also be used as stand-alone application 

in specific projects and by advanced users. 



Introducing IRISConnect 

10 

Refer to the separate Technical Note IRISConnect as Stand-alone 

on the IRISConnect cd-rom for more information. 

Note, however, that no Technical Support is offered when using 

IRISConnnect as stand-alone. 

TARGET AUDIENCE OF THIS MANUAL 

This manual is above all intended for Administrators who want to 

connect the I.R.I.S. solutions IRISPowerscan, IRISDocument 

Server, IRISCapture Pro and IRISXtract for Documents to the ECM 

and CRM systems supported by IRISConnect. 

Supported versions of I.R.I.S. solutions as input 

source 

The instructions in this manual apply to the following I.R.I.S. 

product versions: 

 IRISPowerscan 9.6 

 IRISDocument Server 9.5.0.2 

 IRISCapture Pro for Invoices 8.51 

 IRISXtract for Document 3.2 

Containing: 

o IRISXtract Solution Designer 3.2.0 Hotfix 1 

o IRISXtract Solution Designer Export Plugin 1.0.10 

o IRISXtract Solution Package Accounts Payable 5.0.7.0 for 

Xtract 3.2.0 
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o Xtract Project Solution Package Accounts Payable 5.5.x 

 IRISNext 7.4 

 Important note: make sure you have the correct product version. 

A good understanding of the above-mentioned I.R.I.S. products and 

ECM systems is required. For detailed information about these 

I.R.I.S. products, refer to their respective User Guides. 

To update any of the I.R.I.S. products, contact I.R.I.S. Technical 

Support at activation@iriscorporate.com. 

HOW TO USE THIS MANUAL 

This manual consists of 3 big parts: 

Part 1: Common Configuration of IRISConnect 

In the introduction we mentioned that all connectors are built 

around the same backbone. As a result, a large part of the 

configuration is common to all connectors. 

Information about the common configuration can be found in Part 

1. 

Part 2: IRISConnect combined with I.R.I.S. solutions as input 

source 

In Part 2 we explain how to configure IRISConnect combined with 

the supported I.R.I.S. solutions. 

Although the common configuration always stays the same, the way 

to access IRISConnect from within the I.R.I.S. solutions differs 

from one solution to another. For instance in IRISPowerscan you 

can either use the Configuration Wizards, do a manual 

mailto:activation@iriscorporate.com
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configuration, or even a combination of both, while in the other 

solutions you can only do a manual configuration. 

So, the differences between the I.R.I.S. solutions are discussed in 

Part 2. When necessary, we refer to the common configuration of 

IRISConnect in Part 1. 

Part 3: Particularities about the Connectors 

In Part 3 we try to give an overview of the particularities of each 

connector.  

Since each ECM system has certain rules – such as a document 

hierarchy for instance – that must be respected, the configuration 

rules slightly differ from one connector to another. 

Also, different ECM systems use a different terminology. Some 

system categorize documents into folders > documents > objects, 

while other talk of cabinets > files > etc. Hence, different option 

names will be displayed in the IRISConnect configuration windows. 

The most important differences can be found in Part 3. 

Important note: to configure IRISConnect for Toolbox and 

IRISConnect for ODBC, refer to the separate Technical Notes on 

the IRISConnect cd-rom.
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INSTALLATION AND SETUP 

SYSTEM REQUIREMENTS 

 A Windows XP, Windows Server 2003 (32 and 64 bit), 

Windows Vista (32 and 64 bit), Windows Server 2008 (32 and 

64 bit) or Windows 7 (32 and 64 bit) Operating System. 

Note: when using Windows XP, you need to install .Net 

Framework 3 or higher. 

 In terms of processing capacity IRISConnect in itself does not 

increase your system requirements. 

If your system is powerful enough to run IRISDocument 

Server, IRISCapture, IRISPowerscan or IRISXtract, you 

will be able to install and use IRISConnect. 

Note: if you want to use the FileNet connector, Microsoft 

Web Services Enhancements 3.0 must be installed. To 

install it, run wse30.msi in the Tools folder of the 

IRISConnect cd-rom. 

 20 MB of disk space. 
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INSTALLATION INFORMATION 

Before you begin: 

Before you install IRISConnect, make sure you have the correct 

version of your IRIS product installed: 

 IRISPowerscan 9.6 

 IRISDocument Server 9.5.0.2 

 IRISCapture Pro for Invoices 8.51 

 IRISXtract for Document 3.2.0 

Containing: 

o IRISXtract Solution Designer 3.2.0 Hotfix 1 

o IRISXtract Solution Designer Export Plugin 1.0.10 

o IRISXtract Solution Package Accounts Payable 5.0.7.0 for 

Xtract 3.2.0 

o Xtract Project Solution Package Accounts Payable 5.5.x 

 IRISNext 7.4 

Earlier versions of these I.R.I.S. products are not compatible with 

IRISConnect. 

Important note:  

If you want to use both IRISPowerscan and IRISDocument Server 

in combination with IRISConnect, make sure to install 

IRISPowerscan first, and then IRISDocument Server.  
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INSTALLING IRISCONNECT 

 Insert the IRISConnect cd-rom in your computer and run the 

Setup.exe file from the cd. 

 Follow the on-screen instructions. 

Once you’ve installed IRISConnect you need to register your 

connectors. The registration section does not apply to IRISXtract. A 

different procedure is required in that case. See the Licensing topic 

on IRISXtract for detailed information. 

REGISTERING IRISCONNECT 

(Attention: this section does not apply to IRISXtract for Documents) 

Before you can use an IRISConnect connector, you must first register it.  

Note that registering offers such advantages as free Technical Support, 

product updates, and so on. 

To register your connectors: 

 From the Windows Start menu, run IRISConnect. 

 Select the connector you want to register, then click Register. 

Note that each connector must be registered separately. 
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 Copy the hardware key and send it to 

activation@iriscorporate.com. 

You'll receive the software key in return. 

 Then enter the software key to register the connector. 

 

 

mailto:activation@iriscorporate.com


IRISConnect
TM

 – Administration and User Guide 

17 

UNINSTALLING IRISCONNECT 

To uninstall IRISConnect: 

 Go to the Windows Control Panel > Programs and Features. 

 Select IRISConnect from the list and click Uninstall. 

This will uninstall all the connectors you have installed. 

 

To uninstall a connector separately: 

 Open the file win.ini from C:\Windows in Notepad. 

 Delete the software key for the specific connector. 

It will be uninstalled from your application. 

PRODUCT SUPPORT 

In case you are having trouble with IRISConnect, contact I.R.I.S. 

Technical Support at https://supportcenter.iriscorporate.com. 

In case of update issues or questions, send an e-mail to 

activation@iriscorporate.com. 

https://supportcenter.iriscorporate.com/
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PART 1:  

COMMON CONFIGURATION  

OF IRISCONNECT 

INTRODUCTION 

In this part we discuss the basic, common configuration of 

IRISConnect, which is the same for each connector and in each 

I.R.I.S. solution. 

A basic, common configuration of IRISConnect consists of the 

following steps: 

 Step 1: establish a Connection to the ECM or Cloud system of 

your choice. 

This step speaks for itself. A connection is required to 

export your documents. 

 Step 2: define a Rule Set. 

Rule sets define which types of documents are exported to 

the ECM system of your choice. 

In IRISPowerscan, for instance, you have Batches and 

Documents as document type. In IRISCapture Pro for 

Invoices, you typically have Invoices. 

Rule sets can also be used to group multiple rules which 

you want to apply to a certain document type. 
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Note: if you don't want to make any distinction between the 

document types, you don't need to define rule sets. In this 

case, just create a default rule set and leave it empty. Next 

you can proceed with Step 3: define rules. 

 Step 3: define Rules 

Rules define the exact location of the exported documents 

on the ECM system. They also define as what kind of 

object your documents will be exported, e.g. as document, 

folder, invoice, brochure, and so on. 

By means of rules you can also do index mapping. This 

means you can indicate which indexes from your I.R.I.S. 

solutions should correspond to which indexes in your ECM 

system. This way, when process indexed documents, your 

exported documents also contain the same indexes in your 

ECM system. 

Each of these three steps is described in detail in the following 

sections. 

OVERVIEW OF THE IRISCONNECT 

CONFIGURATION INTERFACE 

Attention: when using IRISConnect combined with I.R.I.S. 

solutions as input source, the IRISConnect interface must be 

accessed from within those I.R.I.S. solutions. Except when using 

IRISConnect combined with IRISDocument Server. In that case 

you need to access the IRISConnect interface from the Windows 

Programs list. 

Note: if you are using IRISConnect as stand-alone, you also access it 

via the Windows Programs list. 
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The way to access the IRISConnect interface varies from one 

I.R.I.S. solution to another. Refer to Part 2 of this documentation 

for information on how to access IRISConnect from within: 

 IRISPowerscan 

 IRISCapture Pro 

 IRISXtract for Documents 

The IRISConnect interface looks like as follows: 

 

 
Add and set up a connection 

 Delete an object 

 
Copy an object 

 
Check the Properties of an object 

 
Move an object 

 Index object 

Note: “objects” refers to connections, rule sets and rules here. 
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STEP 1: ESTABLISH THE CONNECTION 

1. Click the down arrow right of the green cross and click 

Connection. 

 

2. Name the connection and enter the Server to connect to. 

 

3. Provide any additional credentials. 
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Depending on the ECM system you want to connect to, you may 

need to enter a Username, Password or other credentials. 

4. Then click the Connect button. 

The Not connected warning disappears if the connection is 

set up correctly. Should that not be the case, check the 

server. 

In some ECM systems you first need to connect to the 

server, then select an underlying database and click 

Connect again. 

Note: see Part 3: Particularities about the Connectors to 

check for specific information about the connection. 

5. Now proceed with Step 2: Define Rule Sets 

 

Adding additional connections  

Note that it is also possible to use multiple connections in 1 

configuration. This way you can for instance apply different rule 

sets and rules to export your documents to the same server, or set up 

different connections to export to multiple servers. 

To add a connection repeat Step 1, or select a connection and click 

Copy . 

STEP 2: DEFINE RULE SETS 

Rule sets define which types of documents are exported to the 

ECM system of your choice. 
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In IRISPowerscan, for instance, you have Batches and Documents 

as document type. In IRISCapture Pro for Invoices, you typically 

have Invoices. 

Note: even if you don’t want to make a distinction between 

document types, it is still necessary to create a default rule 

set. Otherwise you will not be able to proceed to Step 3: 

Adding Rules. 

To create a Rule Set: 

 Select the connection you created. 

 Then click the down arrow right of the green cross and click 

Rule Set. 

 

 Name the Rule Set. 

 

 In the Type list, select the types of documents to export. 

The types that are available in this list are the ones that were 

defined in the I.R.I.S. solution you are working with. For 
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instance, in case of IRISXtract you find Invoices and Custom as 

document type. 

In case you don’t want to make a distinction based on the 

document type, select (any). This way, all documents will be 

exported. 

Note that you can also create types manually. 

Creating document types manually in the interface 

o Click the indexing icon . 

o Click the down arrow right of the green cross and click 

New Type. 

 

o Name the type, then add the index fields you want your 

documents to have. 

o When you are done, return to the Rule Set configuration. 

  If necessary, you can apply a Condition to specify more 

complex restrictions for your document types. 

Note that the conditions must be written in C#. 

Example: Field[“document.scan_station”].equals(“my scan 

station”). In this example, only documents coming from a 

specific scan station will be processed.  

Tip: to apply a negative condition, put an exclamation mark 

in front of the expression. 
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 When you are done, click OK and continue with Step 3: Create 

Rules. 

Adding additional Rule Sets 

Note that it is possible to have multiple rule sets within a single 

connection. To add a connection repeat Step 2, or select a rule set 

and click Copy . 

STEP 3: DEFINE RULES 

Once you have created a Rule Set, you can create Rules. 

Rules define how an input object will be transformed into one or 

more output objects. They also define the exact location of the 

output objects. 

 To create rules: 

 Click a Rule Set you created. 

 Then click the down arrow right of the green cross and click 

Rule. 

 

 The Object Mapping window opens on the Generalities tab. 

This window differs slightly from one connector to another. 
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 Click Browse to choose the Path where you want to export 

documents.  

If you leave the path empty your documents are stored in the root 

of your ECM system. 

 Indicate a Name for your documents. 

Note that the naming options differ from one connector to 

another. 
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Also note that each index field you create on the Fields tab 

can be added as name as well. Example: in the image above, 

we created Paid Invoices as document type and we created 

manually the fields Date and Customer. See the section 

Index Mapping for more information on how to create index 

fields. 

 Select as which Object type you want to export your documents. 

The object types you see in the list are the ones that are available 

in your ECM system. 

 

When you are done selecting these options you can do the Index 

Mapping on the Fields tab. 
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INDEX MAPPING 

 Click the Fields tab. 

 

 The fields you see here are the index fields that are available on 

your ECM system for the Object type you selected on the 

Generalities tab. 

The fields that have an asterisk are mandatory. 

 

 Right-click a field to map it to another index field. 

The index fields you see in the right-click menu are: 

- the fields you created manually in the IRISConnect interface, 

via the Index function   
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- Or the fields that are available in your I.R.I.S. solution, if you 

are using IRISConnect from within an I.R.I.S. solution. 

 

Note: if you are using IRISConnect from within an I.R.I.S. 

solution and you don’t see any fields when you right-click, this 

means you haven’t created any indexes in your I.R.I.S. solution. 

Note: when you are doing a fully manual configuration from 

within IRISPowerscan, you can create the index fields in 

IRISConnect and afterwards create the exact same indexes in 

IRISPowerscan. 

How to create index fields in IRISConnect has been explained in 

Step 2: Define Rule Sets. 

Attention: depending on the ECM system you export to, you must 

respect certain structure conventions when creating rules. See Part 

3: Particularities about the Connectors for more information. 
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PART 2:  

IRISCONNECT  

COMBINED WITH  

I.R.I.S. SOLUTIONS AS INPUT 

SOURCE 

INTRODUCTION 

IRISConnect can be used in combination with I.R.I.S.' high-end 

scanning and document management solutions IRISPowerscan, 

IRISDocument Server, IRISCapture Pro and IRISXtract for 

Documents. You will also be able to use it in combination with 

I.R.I.S.’ own ECM system IRISNext as of version 7.4 

In this chapter we discuss how to set up IRISConnect from within 

these I.R.I.S. solutions. The basic, common configuration is similar 

for all connectors and has been discussed in Part 1. 

IRISCONNECT COMBINED WITH 

IRISPOWERSCAN 

IRISConnect can be configured in different ways in combination 

with IRISPowerscan. You can configure it by means of: 

 Convenient Configuration Wizards 
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As soon as you’ve registered an IRISConnect connector, a 

dedicated Quick Project is created in IRISPowerscan. These 

Quick Projects feature the Configuration Wizards that allow 

you to set up IRISConnect in just a few steps. 

Note: when you only use the Configuration Wizard, you 

won’t see the IRISConnect interface. Wizards are useful 

when doing a very basic configuration. 

 Combining the Configuration Wizards with a Manual 

Configuration 

When you create a new Quick Project based on an 

IRISConnect Quick Project, for instance IRISConnect to 

Therefore, you can still use the Configuration Wizard, but 

you also have access to the Project Setup in 

IRISPowerscan. 

 

Via the Project Setup you can then access the IRISConnect 

interface to do a more advanced configuration, using 

multiple Connections, Rule Sets and Rules. 

 A fully manual configuration 

A fully manual configuration of IRISConnect can be done 

when using a new Project based on the Demo project in 

IRISPowerscan. In this case you don’t have any 

Configuration Wizards. 

Attention: when doing a fully manual configuration you 

also need to manually do the index mapping between the 

index fields of your ECM system and those of 

IRISPowerscan. See the section on Index Mapping. 
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Important note: in case you need to process very large quantities 

of batches, you can connect multiple IRISPowerscan stations to 

IRISConnect via IRISDocument Server. In that case, your output 

documents are not generated by the IRISDocument Service in 

IRISPowerscan, but by the more powerful IRISDocument Server 

connector. 

 

For more information on how to include IRISDocument Server in 

the process, see the section on IRISDocument Server + 

IRISPowerscan. 

PRELIMINARY NOTE 

Make sure you have IRISPowerscan version 9.6 installed on your 

system. 

If you have a previous version of IRISPowerscan (9.5) you need to 

update the software: 

 Contact I.R.I.S. Technical Support at 

activation@iriscorporate.com to obtain the IRISPowerscan 

9.6 Updater cd-rom. 

 Insert the IRISPowerscan 9.6 updater cd-rom in the cd-rom drive 

of your computer. 
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 Run the IRISPowerscanUpdater.exe from the cd-rom and 

follow the on-screen instructions. 

IMPORTANT NOTE ABOUT THE IRISPOWERSCAN 

9.6 UPDATE 

We mentioned that IRISConnect is compatible with IRISPowerscan 

as of version 9.6. 

In the previous version of IRISPowerscan, version 9.5, there were 

already a few connectors that are now covered by IRISConnect. 

These connectors are Therefore, SharePoint, FileNet and 

IRISNext. Consequently, there are a few particularities to take into 

account when updating from IRISPowerscan 9.5 to IRISPowerscan 

9.6. 

Particularities 

 In case the Therefore, FileNet or IRISNext connectors were 

registered in IRISPowerscan 9.5: 

Then, they will also be registered when you update to 

IRISPowerscan 9.6 and install IRISConnect. 

The old connector Quick Projects are replaced by the new 

Quick Projects. For instance, instead of Scan to Therefore, 

you’ll see IRISConnect for Therefore. 

The configuration of the old connectors is still accessible 

from the Connectors list in Project Setup > Processing. 

This way, users can convert their existing projects manually 

to the IRISConnect configuration. The old connectors will 

not be visible in the Add-ons list on the Help menu. 

 In case the SharePoint connector was registered in 

IRISPowerscan 9.5: 
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Then you will still see the old Quick Project when you 

update to IRISPowerscan 9.6 and install IRISConnect. 

The new SharePoint connector is not registered 

automatically by upgrading. You need to obtain a new 

software key. 

When you register the new IRISConnect for SharePoint 

connector, the old connector remains available. In other 

words, the two connectors and their corresponding Quick 

Projects co-exist. It is recommended to use the new 

IRISConnect connector, though. 

 In case the Therefore, SharePoint, FileNet and IRISNext 

connectors were not registered in IRISPowerscan 9.5: 

Then, they are simply replaced by the new IRISConnect 

connectors when you update to IRISPowerscan 9.6 and 

install IRISConnect. 

To update IRISPowerscan 9.5 to version 9.6: 

 Insert the IRISPowerscan 9.6 updater cd-rom in the cd-rom drive 

of your computer. 

 Run the IRISPowerscanUpdater.exe from the cd-rom and 

follow the on-screen instructions. 

USING THE IRISPOWERSCAN CONFIGURATION 

WIZARDS 

As soon as you’ve registered an IRISConnect connector, a 

dedicated Quick Project is created in IRISPowerscan. 

Example 
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Tip: to learn how to register a connector, see the topic Registering 

IRISConnect. 

The Quick Projects use predefined settings and contain the 

Configuration Wizards. 

The Configuration Wizards guide you through the different steps of 

a quick, basic configuration. Once you have gone through the 

steps, the documents you scan and process are exported via 

IRISConnect. The IRISPowerscan Project Setup is unavailable. 

This means you cannot change any other (advanced) 

IRISPowerscan settings outside the Wizard. 

All Wizards are structured in the same way, for every connector. 

There are only slight differences when it comes to setting up a 

connection. This is due to the fact the various ECM systems require 

different login credentials. The particularities of each ECM system 

can be found in Part 3: Particularities about the Connectors. 

Starting the Wizard 

 In the IRISPowerscan start-up screen, double-click the Quick 

Project of your connector to start the Configuration Wizard. 
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Tip: if you want to use the Configuration Wizard combined with a 

Manual configuration, right-click your Quick Project and click New to 

create a new Quick Project. See the topic Using the Configuration 

Wizards combined with a Manual Configuration for more 

information. 

 The Wizard goes through the following steps: 

Step 1: Connect to the Server 

This is the mandatory step. 

 

 Enter the server link and your login credentials. 

The login credentials differ from one ECM system to 

another, so this screen also differs from one connector to 

another. Again, see Part 3: Particularities about the 

Connectors. 

 Then click the Connect button. 

Note: in some case you need to click Connect twice: one 

time to establish the connection, and one time to connect to 

the underlying database/category/etc. 
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 Click Next to continue with Step 2 or click Finish to open the 

project/package and start processing documents. 

Step 2: Define document fields 

Based on the settings you selected in Step 1, the Wizard 

automatically retrieves all the corresponding fields that are available 

in your ECM system. 

Example 

Suppose you selected Invoices at Step 1 of the Therefore Wizard. 

Then you will see the following available fields at step 2. 
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The fields you see listed in Step 2 of the Wizard are the ones that 

are available in your ECM system - in this case Therefore. 

 Select the document fields you want the Wizard to create in 

IRISPowerscan. 

By default, the Wizard creates them all. 

The document fields you select in step 2 of the Configuration 

Wizard appear in the Index section of IRISPowerscan after 

scanning a batch or document. When you fill in the index fields 

in IRISPowerscan, they will be exported to the corresponding 

index fields in your ECM system. Hence, you can export fully 

indexed documents thanks to IRISConnect. 
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If you keep the default option Use custom data types activated 

in step 2 of the Wizard, then you have to fill in the document 

types fields according to specific naming conventions in 

IRISPowerscan. The fields that are mandatory are marked in red. 
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If you deactivate the option Use custom data types in the 

Wizard, then all document fields can be filed in as text in 

IRISPowerscan. 

 When you are done, click Next to continue the configuration or 

click Finish to open the project/package and start processing 

documents. 

Step 3: Define document formats 

During this step you can select the output format you want to 

generate. 

Note: IRISPowerscan uses I.R.I.S.’ iHQC technology. iHQC
TM

 is 

patent-protected. US Patent No. 8,068,684. 

 

 Select the options of your choice: 

PDF 
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o PDF Image-Text generates searchable PDF files that 

contain the original page image on top of the recognized 

text. 

o PDF Image generates image PDFs. They are not text-

searchable. 

o PDF Text generates Text PDFs and creates graphic zones 

as images. 

o PDF Text-Image generates PDF files in which the 

recognized text is placed on top of the image. 

o PDF/A compliant generates PDF/A files that are suitable 

for long-term archiving. 

PDF-iHQC: generates highly-compressed PDF files using 

intelligent High-Quality Compression technology. 

The PDF-iHQC files can also be PDF/A-compliant. 

 

XPS 

o XPS Image-Text generates searchable XPS files that 

contain the original page image on top of the recognized 

text. 

o XPS Image generates image XPS files. They are not text-

searchable. 

o XPS Text-Image generates XPS files in which the 

recognized text is placed on top of the image. 

 

XPS-iHQC: generates highly-compressed XPS files using 

intelligent High-Quality Compression technology. 
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RTF: generates RTF (Rich Text Format) files. 

Word: generates Microsoft Word files. 

WordML: generates WordML files (supported by Microsoft 

Word 2007 and 2003). 

SpreadSheetML: generates SpreadsheetML output (supported 

by Microsoft Excel 2007, 2003 and 2002). 

OpenDocument: generates OpenDocument files (XML-based 

open format). 

Multipage TIFF: generates Multipage TIFF files. 

 

 Click Next if you want to continue the configuration or click 

Finish to open the project/package and start processing 

documents. 

 

Step 4: Define document separators 

During this step you can select how you want to separate your 

documents. You can separate documents based on blank pages, 

barcodes and patch codes. When IRISPowerscan encounters one 

of those it will know to start a new document. You can also 

configure IRISPowerscan to start a new document after a certain 

number of pages (page count). 
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Separation options 

o blank pages 

o barcodes 

Select the type of barcode that will be used to separate 

documents. 

Field: indicate the index field (of the Index Pane in 

IRISPowerscan) where the barcode values must be 

inserted. 

o patch code 

Select the type of patch code that will be used to separate 

documents. 

o page count 

Indicate after how many pages you want IRISPowerscan to 

start a new document. 
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 When you are done, click Finish to open the project/package and 

start processing documents. 

 

Next steps 

Go to the ECM system you defined in Step 1 of the Wizard to find 

your exported documents. 

USING THE CONFIGURATION WIZARDS 

COMBINED WITH A MANUAL CONFIGURATION 

In case you want to use the Configuration Wizards but also want to 

have access to the IRISConnect interface to do a manual 

configuration, then you need to create a new Quick Project based on 

your connector's Quick Project. 

To create a new Project: 

 Right-click the Project and click New. 

 

 Name the new Project and make sure to keep the default 

location. 
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 Click OK to start the Configuration Wizard. Then go through the 

steps we discussed in the section Using the IRISPowerscan 

Configuration Wizards 

 When you are done, you can access the IRISConnect interface 

via Project Setup . 

 Click the Processing tab, select your connector from the 

Connector list and click Setup. 

 

 

 The IRISConnect interface opens.  

The connection you established via the Wizard will be 

displayed. 
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Now you can add Rule Sets and Rules, modify the Index 

mapping, add additional connections, and so on. 

 

Next steps 

When you are finished with the configuration, return to your Project 

to scan and process your documents. 

Tip: before trying to export batches of documents, scan and process 

just a few documents first. Then go to your ECM system and check 

if: 

 all documents have been exported 

 all documents are exported correctly to the right location 

 all indexes are filled in and displayed correctly 

DOING A FULLY MANUAL CONFIGURATION 

In IRISPowerscan you can also do a fully manual configuration of 

IRISConnect. 

A manual configuration allows you to configure all possible 

IRISPowerscan settings. You don’t use any predefined settings 

from the Configuration Wizards. 
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To do a fully manual configuration, you must first create a new 

Project from scratch. 

To do so: 

 Right-click the Demo project and select New. 

 Name the new Project and make sure to keep the default 

location. 

 

 Then go to the Project Setup  to access the IRISConnect 

interface. 

 Click the Processing tab, select your connector from the 

Connector list and click Setup. 
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 The IRISConnect interface opens.  

Now you can add Rule Sets and Rules, create Index fields 

and do the Index mapping, add additional connections, and 

so on. Refer to Part 1 to learn how to do so. 

 

Important note: when you are doing a fully manual configuration, 

you must first create index fields in IRISPowerscan before you can 

map them to the index fields of your ECM system. Refer to the 

complete IRISPowerscan documentation to learn how to create 

Indexes in IRISPowerscan. 

Next steps 

When you are finished with the configuration, return to your Project 

to scan and process your documents. 

Tip: before trying to export batches of documents, scan and process 

just a few documents first. Then go to your ECM system and check 

if: 

 all documents have been exported 

 all documents are exported correctly to the right location 

 all indexes are filled in and displayed correctly 
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IRISCONNECT COMBINED WITH 

IRISDOCUMENT SERVER + 

IRISPOWERSCAN 

If you need to scan and process huge quantities of documents, it 

may be useful to connect multiple IRISPowerscan stations to 

IRISConnect. You can do this by including IRISDocument Server 

in the process. 

With IRISDocument Server it's possible to configure multiple 

Watched Folders to which the different IRISPowerscan stations 

send their scanned documents. The conversion of the scanned 

documents into output formats is no longer done inside 

IRISPowerscan by the IRISDocument service, but outside 

IRISPowerscan thanks to the more powerful IRISDocument 

Server connector. 

Note: in order to include IRISDocument Server in the process you 

need to have access to the Project Setup inside IRISPowerscan. 

Consequently you need to create a new Quick Project based on an 

existing Connector Quick Project or based on the Demo project. 

PRELIMINARY NOTE 

Make sure you have IRISPowerscan version 9.6 and IRISDocument 

Server 9.5.2 installed on your system. 

In case you need to update a previous IRISPowerscan 9.5 version to 

9.6, refer to the Preliminary note in the IRISPowerscan section. 

To update from a previous version of IRISDocument Server, 

contact I.R.I.S. Technical Support at 

irisdocument@iriscorporate.com to obtain a new installation cd-

rom. 

mailto:irisdocument@iriscorporate.com
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DESCRIPTION OF THE IRISPOWERSCAN - 

IRISDOCUMENT SERVER - IRISCONNECT 

PROCESS 

The different IRISPowerscan stations scan their documents. They 

are sent to IRISDocument Server for conversion. IRISDocument 

exports them to IRISConnect so that the indexes from 

IRISPowerscan are maintained in the ECM systems you export 

them to. 

Despite the seemingly many steps, this is an automatic and speedy 

process, once it has been configured correctly. 

PRELIMINARY REQUIREMENTS 

 IRISDocument Server requires a customized ids.bat to be able to 

call an IRISConnect connector. See the topic Creating a 

customized ids.bat file. 

 You need to set up a Watched Folder in the stand-alone 

application IRISDocument Server, before you can configure the 

IRISDocument Server connector from within IRISPowerscan. 

See the topic Set up a Watched Folder for more information. 

Note: in case you want to use IRISDocument Server as a stand-

alone application to send documents to IRISConnect, see the 

section IRISDocument Server stand-alone. Note, however, that 

IRISDocument is not able to send indexed documents. 

Consequently, you must make sure that your ECM system does not 

contain mandatory index fields, since IRISDocument will not be 

able to fill them in. 
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CREATING A CUSTOMIZED IDS.BAT FILE 

 Open Notepad. 

 Then type the following: 

set home=C:\Program Files\IRISConnect 

call "%home%\IRISConnect.exe" 

"%home%\Data\YOURCONNECTOR.xml" %1 /ids 

/target:IRISConnect.YOURCONNECTOR.dll 

Example 

 

Note that “YOURCONNECTOR" must be replaced by the 

connector of your choice, e.g. call "%home%\IRISConnect.exe" 

"%home%\Data\Therefore.xml" %1 /ids 

/target:IRISConnect.Therefore.dll 

 Then click File > Save As and name the file ids.bat. 

Make sure the extension is .bat and not .txt. 

 

Important notes: 

 In order for the ids.bat file to work, your connector must be 

registered correctly in IRISConnect. 
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 An xml configuration file must exist for your connector in 

C:\Program Files\IRISConnect\Data 

Tip: if you don’t have an xml file for your connector, follow the 

following procedure: 

- Open IRISConnect from the Windows Programs menu. 

- Then double-click your connector (provided it’s registered) 

- Click the green cross. You will be prompted to save a xml file in 

C:\Program Files\IRISConnect\Data 

 

Example 

 

SET UP A WATCHED FOLDER IN IRISDOCUMENT 

SERVER 

In this topic we discuss how to set up a Watched Folder in the 

stand-alone application IRISDocument Server. 

This step is necessary in order to be able to select a Watched Folder 

in the IRISDocument Server Connector from within 

IRISPowerscan. Once you have set up a Watched Folder, see the 



IRISConnect
TM

 – Administration and User Guide 

53 

section See Configuring the IRISDocument Server connector 

from within IRISPowerscan. 

 

To set up a Watched Folder: 

 From the Windows Start menu, select 

Programs>IRISDocument Server 9.5>Watched Folders. 

 When you run IRISDocument Server for the first time, you will 

be prompted to indicate a work folder in which IRISDocument 

stores all temporary data that is being processed, such as image 

and log files, and temporary and undelivered results. 

This work folder should be located on a hard disk that has 

sufficient free memory. 

 

   

Note: if you installed the Workgroup add-on and selected 

Workgroup initial data during the installation, then a complete 

Watched Folder configuration will be preconfigured. The 

preconfigured work folder will be located in 

C:\IRISDocument_9.5\Storage. 

 Select a location, or create a new one on your computer, which 

you want to use as work folder. 
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Note that IRISDocument Server must have fast access to the 

work folder. Therefore, it is mandatory you select or create a 

folder on a local hard disk instead of on a network. Bandwidth 

and network issues, such as time-outs, inconsistent time or time 

zone settings etc., might slow down IRISDocument Server 

considerably. 

 As soon as you click OK, the empty user interface will open. 

 

 Open the File menu and click the command Create a Watched 

Folder. 

 In the window that opens, click Browse to browse for the folder 

you want to use as Watched Folder. 

Important note: this must be the folder where IRISPowerscan 

stores its scanned images. By default, this is 

C:\IRISPowerscan\Batches. 
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 Then select the Watched Folder settings. 

Image folder 

IRISDocument Server can either Process the root of a selected 

folder or Process the subfolders. 

When processing the root of a selected folder, the images are erased 

automatically from that folder once they have been processed. 

Otherwise, they would be processed over and over again. 

When processing the root of a selected folder, IRISDocument also 

processes the images that are located at 1 level below the root. 

When processing the subfolders, the root folder is ignored and only 

the subfolders are processed. The images and subfolders are deleted 

after task creation by default, and stored in the work folder. You can 

also choose to keep a copy of the documents in their original folder 

by clearing the box Delete document after task creation. These 

documents will not be processed over and over since 

IRISDocument Server can detect which documents are already 

being processed by means of run files.  

End of task detection 

The End of task detection options allow you to determine how the 

stream of scanned images will be broken up in separate tasks. 
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Time-out 

If the contents of a watched folder do not change for a certain time, 

IRISDocument Server will start converting all documents in that 

folder as a single task. 

File detection 

When processing subfolders, you can drop an end of task file 

(eod.inf) in a watched folder. As soon as IRISDocument Server 

encounters the file, it will know the task is completed and it will 

start the next one. All documents up to the eod file will be 

processed as part of a single task. Note: make sure to arrange you 

documents in the right order up to each eod file. Otherwise your 

output documents will be processed incorrectly. 

For each task indicated by an end of task file, IRISDocument Server 

creates a run file in the image folder, to indicate to the user that this 

specific task is being processed. 

All images for which a run file exists are ignored as the folder 

monitoring continues. This way, the images do not need to be 

removed from the source image folder. 

Note, however, that the End of task detection settings are not the 

only way to organize a stream of scanned documents. There are also 

specific document separation options to select. Consult the 

separate IRISDocument Server documentation for more details. 
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Processing 

IRISDocument Server handles several watched folders 

simultaneously. The watched folder with the highest priority is 

processed first. 

 

Open the Task menu to change the priority of specific tasks. Note, 

however, that the Task menu cannot be opened when the OCR is in 

progress; the current process needs to be aborted first. 

Options 

 IRISDocument by default loads PDF and DjVu documents in 

color. Should you want to load these documents in black-and-

white to reduce the processing time, then clear this option. 

 Note: do not select the option Don't modify PDF containing 

text. This option will cause problems combined with 

IRISPowerscan and IRISConnect. 

When processing PDF documents, IRISDocument first converts 

them into image files (This process is called rasterization). The 

image files are then processed and converted into output documents.  

The resolution at which IRISDocument extracts image files from 

PDF documents can be determined: select the appropriate resolution 

in the drop-down list, right of Load PDF at: 
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o IRISDocument by default loads PDF documents at 300 

dpi. 

o Select 200 dpi to increase the processing speed. 

o Select 600 dpi to increase the processing accuracy. 

 Select overwrite task output in case you want to overwrite the 

documents that are left in the output folder when starting another 

task. 

Next steps 

 When you are done configuring the Watched Folder settings, 

keep clicking Next until you reach the Output folder step. 

Select any output folder. This output folder is of no importance 

here in the IRISPowerscan – IRISDocument Server - 

IRISConnect process. 

 Then keep clicking Next again until you reach the Export step. 

Copy the file ids.bat you created to the folder on the computer 

where IRISDocument Server is installed. 

 Now click the Browse button and indicate in which folder the 

ids.bat file is stored. 
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 Click Next again, and then click Finish. 

 Next, go to the File menu and click Run to start monitoring the 

Watched Folder. 

 

 Once you have completed these steps, you can configure the 

IRISDocument Server connector from within IRISPowerscan. 

 

Notes 

The processing can be aborted by means of the Abort command in 

the File menu. 

Note that aborting the process may take some time. IRISDocument 

always finishes the task in progress before interrupting. Watched 

folders cannot be created, edited or removed when the OCR is in 

progress. 
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When the process is aborted, the lower part of the interface displays 

the pending tasks and their status. 

 

The status of the various OCR tasks can also be verified in the work 

folder. 

The pending tasks can be edited in the Task menu: select the tasks 

you want to edit in the lower part of the application and click the 

command Edit selected tasks. 

CONFIGURING THE IRISDOCUMENT SERVER 

CONNECTOR FROM WITHIN IRISPOWERSCAN 

Once you have set up a Watched Folder in IRISDocument Server, 

you can configure the IRISDocument Server connector from within 

IRISPowerscan. 

To do so: 

 Open the Quick Project you created. 

 Access the the Project Setup by clicking  in the main 

toolbar. 

 Then click the Processing tab. 

 In case the IRISDocument Service is activated, deactivate it. 
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 In the Connector list, select IRISDocument Server, then click 

Setup. 

 

 In the window that opens, click Watched Folder. Then browse 

for the Watched Folder you created in the stand-alone 

application IRISDocument Server. 

 

 Then click Batch Output. Select Enable XML indexing and 

Include recognized text. Then select Batch folder instead of 

Output folder. 

 

 Click Document Output and select the output formats you want 

to generate. 
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Refer to the complete IRISDocument Server documentation for 

more information about the possible output formats. 

 When you are done here, you can start scanning documents in 

IRISPowerscan. They will be sent to the ECM system you 

configured. 

IRISCONNECT COMBINED WITH 

IRISDOCUMENT SERVER 

IRISDocument Server can also be configured as stand-alone 

application to send documents via IRISConnect. 

Note, however, that IRISDocument Server is not able to index 

documents. Consequently, your documents will not contain indexes 

in your ECM system. 

Attention: if your ECM system has mandatory index fields, which 

must be filled in, then the export via IRISDocument Server will 

fail. Therefore, make sure your ECM system does not contain 

mandatory fields. If you cannot modify the mandatory fields, 

contact the ECM system administrator. 

PRELIMINARY NOTE 

Make sure you have IRISDocument Server version 9.5.0.2 installed 

on your system. 

If necessary, contact I.R.I.S. Technical Support at 

irisdocument@iriscorporate.com to obtain the correct installation 

cd-rom. 

mailto:irisdocument@iriscorporate.com
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CONFIGURING IRISDOCUMENT SERVER WITH 

IRISCONNECT: 

 Configure your IRISConnect connector as explained in Part 1. 

Important note: remember to save your connector’s configuration .xml file. 

Then close the IRISConnect application before processing your documents 

with IRISDocument Server. 

 Configure IRISDocument Server like you would normally do. 

When you come to the Export tab, and browse your connector’s 

customized ids.bat file. 

 

To learn how te create the required .bat file refer to the section 

Creating a customized ids.bat file. 

 

IRISCONNECT COMBINED WITH 

IRISCAPTURE PRO 

IRISCapture Pro can be used in combination with IRISConnect to 

send your invoices and forms to the ECM systems of your choice. 

Note: the procedures described in this documentation currently 

apply to IRISCapture Pro for Invoices only. 
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PRELIMINARY NOTE 

Make sure you have IRISCapture Pro version 8.51 installed on your 

system. 

In case you need to update from a previous 8.5x version: 

 Log in to the I.R.I.S. maintenance site at 

http://maintenance.irislink.com. 

 Go to the IRISCapture Pro for Invoices section and download 

the patch called ICP 8.51i. 

 Or contact I.R.I.S. Technical Support at 

activation@iriscorporate.com. 

UPDATE TO VERSION IRISCAPTURE PRO 8.51 

Once you’ve downloaded the patch you can complete the update: 

 Go to C:\Program Files\IRISCapture85\Applic. 

 Delete the Binary folder. 

 Copy the content of the patch you downloaded to the Applic 

folder. 

CONFIGURING THE IRISCAPTURE TO 

IRISCONNECT CONNECTOR 

 Go to C:\Program Files\IRISCapture85\Applic\. 

 Double-click ICPToIRISConnectSetup.exe to open the 

connectors’ configuration window. 

 Log in to the database of your choice. 

http://maintenance.irislink.com/
mailto:activation@iriscorporate.com
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 Then select your connector and click Select output formats. 

 

 Select the output format of your choice. 

 

 Return to the connector screen and click Setup connector. 

SETTING UP THE CONNECTOR 

To set up the connector, you need to take into account the document 

structure in IRISCapture; you need to define which indexes your 

scanned input documents contain on batch level, document level 

and object level. This step is required if you want to keep the 

existing indexes and have them filled out automatically in the ECM 

system you will be exporting to. 

 Click the indexing icon. 
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 As you see, the Signal type is created automatically. Do not 

change anything about this type. 

 

 Then click the down arrow right of the green cross and add new 

Document types, depending on the structure of the batches you 

are processing. 

Two structures are possible in IRISCapture. You can have: 

Batch > Document > Object > Page 

or 

Batch > Object > Page. 

Attention: if your batches or documents (which come from your 

scanning application) do not contain indexes, then it's not 

necessary to create a type for them at this stage. 

Tip: the easiest way to see the structure of your documents, and 

to see which indexes you have, is to process a batch and export it 

with IRISCapture. Once you have exported a batch, you can 

check its .xml file to check the structure. 

To process and export a test batch: 
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o Go to C:\Program Files\IRISCapture85\Applic. 

o Double-click Util.exe 

o Select the database you want to open. 

 

o In the Administration window that opens, click Settings 

in the left-hand column, click the Export tab and make 

sure XML is selected as format.  

 

o Now exit the Administration module and process a batch 

in IRISCapture. 

o Once you have exported a batch, go to 

C:\Work\IRISCapture85\BEL_PROD\Export. 
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Note that BEL_PROD is the name of the database. If you 

are using a different database, then open the Export folder 

in that database. 

o Then, open the XML file you find there with Notepad. 

 

o In this example XML below, you'll notice that there are no 

indexes on Batch level or Document level. There are only 

indexes on Object level. This entails it is not necessary to 

create new types on batch or document level when setting 

up the connector. 

 

 Now return to the connector inside IRISCapture and click the 

Indexing icon. 
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 Click the down arrow right of the green cross and click New 

Type. Enter ObjectIndexes as name for the type. 

   

 Click the down arrow again and then click New Field. Now 

select which index fields you want to recreate in your ECM 

system. For instance "Invoice number" and "Invoice date"  

 

Note that you need to take the Name as index field for the 

ObjectIndexes, and not the ID. (See the XML example image 

above). 

Important note: in case you do have indexes on Batch level or 

Document level, and you want create fields, then you need to 

use their ID instead of their name.  

 

Example: <DocumentIndex ID="1" Name="Document" 

Value="123456"/>. In this case, you create a new field and name 

it "1". 

 

 Then add the Type of documents you are processing. In 

IRISCapture for Invoices, this is always "Invoice". 
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 Next, create New Fields for the Invoice. These index fields will 

be recreated in your ECM system. 

In a standard configuration of IRISCapture for Invoices, the fields 

you can add on the Objects level are: 

Date 

Total without VAT 

VAT amount 

Total Amount to pay 

Invoice Number 

Currency 

Table sum 

Notice that these are also the names, and not the ID's. 

 Once you are done creating the types and fields, you can proceed 

with the rest of the IRISConnect configuration: 1) setting up a 

connection to your ECM system, 2) defining rule sets, 3) 

defining rules and doing the field mapping.  

Refer to Part 1 of this guide Common Configuration of 

IRISConnect to learn how to do so. 

 When you are done, Save the configuration.  

file:///C:/Documentation/IRISConnect/IRISConnect%205.12/html/part_1__common_configuration_of_irisconnect.htm
file:///C:/Documentation/IRISConnect/IRISConnect%205.12/html/part_1__common_configuration_of_irisconnect.htm
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All you have to do now is enable the Post-Export in IRISCapture. 

ENABLING THE POST-EXPORT IN IRISCAPTURE 

 Go to C:\Program Files\IRISCapture85\Applic. 

 Double-click Util.exe 

 Select the database you want to open. 

 

 the Administration window that opens, click Pre/Post 

processing in the left-hand column. 

 Then select the Export option indicated below. 
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Now you can start processing invoices with IRISCapture and send 

them to the ECM system you configured. 

 

You can also repeat the procedure described above for other 

databases and other connectors. 

Important notes: if you are scanning invoices by means of 

another application - such as IRISPowerscan or IRISXtract - it is 

possible that you have already defined different indexes in those 

applications. In case you want IRISCapture to maintain them, you 

need to create the necessary Types and Fields inside the connector. 

In that case you cannot use the default indexes from the XML file. 

IRISCONNECT COMBINED WITH 

IRISXTRACT FOR DOCUMENTS 

All connectors that are offered by IRISConnect are integrated in 

IRISXtract for Documents.  

They can be configured in the Solution Designer of IRISXtract. 
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PRELIMINARY NOTES 

SYSTEM CONFIGURATION 

Make sure you have the following version of IRISXtract for 

Documents installed on your system: 

IRISXtract for Document 3.2.0 containing: 

 IRISXtract Solution Designer 3.2.0 Hotfix 1 

 IRISXtract Solution Designer Export Plugin 1.0.10 

 IRISXtract Solution Package Accounts Payable 5.0.7.0 for 

Xtract 3.2.0 

 Xtract Project Solution Package Accounts Payable 5.5.x 

In case you need to update from a previous version, contact I.R.I.S. 

Technical Support at activation@iriscorporate.com. 

LICENSING 

In order to use IRISConnect from within IRISXtract you need to 

update the licenses in IRISXtract. 

Note: if you do not have an IRISXtract license yet, but want to 

acquire one, follow the same procedure described below. 

There are 2 scenarios: either your license is contained in a local or 

server dongle (dongle licensing), or in a license file (software 

licensing).   

To obtain an updated license: 

In case of a software license: 
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Send an e-mail to activation@iriscorporate.com and provide the 

following information: 

1. Specify what kind of license you need. There are 2 scenarios: 

a. You have a local or server dongle license that needs 

updating (dongle licensing). 

b. You have a license file that needs updating (software 

license) 

2. Provide Client Information 

a. Partner Name (if necessary) 

b. Name of End-user 

3. Mention you need a default licensing package (e.g. Solution 

PackageAccounts Payable default licensing) 

4. Specify which special keys must be included in the license: 

a. Required volume 

b. Any special engines 

c. iHQC compression 

d. Specific connectors 

E.g. ExportConnectorTherefore, 

ExportConnectorSharePoint 

e. Non-iHQC PDF output (if necessary) 

f. Designer and/or Solution Designer (if necessary) 

Note: Solution Designer does not need to be activated 

if it is only used to configure the connectors. 

You will receive an updated license file in return. 

mailto:activation@iriscorporate.com
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In case of a dongle license: 

The procedure to obtain an updated dongle license is the same as for 

a software license, except the fact that you also need to include your 

dongle’s .rtc file in your mail to activation@iriscorporate.com. 

To do so: 

 Go to Windows Control Panel > Hardware and Sound > 

Wibu Key Tool. 

 Click the Wibu key icon in the left corner of the title bar, then 

select Advanced mode. 

 

 Click the WIBU-BOX Context tab. 

 Select your dongle in the list. 

Note: make sure the dongle(s) is/are plugged in correctly. 

The Designer and Solution Designer modules need the 

dongle to be connected locally 

 Click on the Browse button to save the RTC file to a location of 

your choice. 

 Now send the RTC file to I.R.I.S. You’ll receive an RTU file 

and a license file in return. 

Importing the updated dongle license 

Once you’ve received the RTU file from I.R.I.S.: 

mailto:activation@iriscorporate.com
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 Go to Windows Control Panel > Hardware and Sound > 

Wibu Key Tool. 

 Click the Wibu key icon in the left corner of the title bar, then 

select Advanced mode. 

 Click the WIBU-BOX Update tab. 

 Select your dongle in the list. 

 Click on the Browse button to open the RTU file you received 

by e-mail. 

Importing the updated license file 

When you’ve sent all the required information to I.R.I.S Technical 

Support, they will send you the updated license file. 

Important notes: 

 If you have a software license, there are 2 ways to import the 

updated license file: 

o Via the Setup Wizard, in case you re-install IRISXtract 

completely 

o Manually in the Production Manager, Solution Designer (if 

required) and Designer (if required). 

 If you have a dongle license, you need to do it manually. 

Via the Setup Wizard 

 Insert the IRISXtract cd-rom in the cd-rom drive of your 

computer. 

 Run the Setup Wizard. 

 You will be prompted to specify the license file. 
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Manually 

In the Production Manager module: 

 In the Settings menu, click Import license file. 

 Browse for your license file and click Import. 

Note: you’ll need to activate the license, in case of a software 

license. 

In the Solution Designer module: 

 In the Tools menu, click Import license file. 

 Choose Yes and browse for the file to import. 

 Then, go the File menu and click Deploy projects to WOM. 

Note: you’ll need to activate the license, in case of a software 

license. 

In the Designer module: 

 In the Tools menu, click Import license file. 

 Choose Yes and browse for the file to import. 

Note: you’ll need to activate the license, in case of a software 

license. 

Activating the license file 

After importing the new license file, you will be prompted to enter 

the activation code when you start IRISXtract. 

Note: if you are using a dongle license, and the license mode is set 

up correctly to dongle licensing, you will not be asked to activate. 
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 Send the identification number you see in the pop-up window to 

activation@iriscorporate.com. 

Important note: leave the pop-up window open until you 

received the activation code. 

 Enter the activation code you receive from I.R.I.S. Technical 

Support. 

CONFIGURING CONNECTORS IN 

IRISXTRACT: 

 From the Windows Start menu, open the IRISXtract Solution 

Designer. 

Note: you need have administrator rights to configure the 

Solution Designer. 

 

 Open the project in which you want to configure the 

connector(s). 

mailto:activation@iriscorporate.com
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 In the bottom left corner of the screen, click Export 

Configuration. 

 

 Select the connector of your choice, then click Select output 

formats. 

Note: IRISConnect has to be installed in order to see the 

connectors. See the section Installation for installation details.  

 

If IRISConnect has not been installed, only the Xtract Export 

folder is visible. 
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 Select the output format of your documents. 

 

Note: to export PDF documents and iHQC-compressed PDF 

documents special licenses are required. Contact I.R.I.S. to 

acquire them: activation@iriscorporate.com. 

Note: iHQC is a technology created by I.R.I.S. iHQC is patent-

protected. US Patent No. 8,068,684. 

 Then exit the Output formats dialog box and click Setup 

connector. The IRISConnect interface appears. 

 

mailto:activation@iriscorporate.com
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 Now proceed with the common configuration of IRISConnect. 

See Part 1: Common Configuration of IRISConnect for more 

information.  

 When you are done configuring the connectors, go to the File 

menu in IRISXtract Solution Designer and click Deploy project 

to WOM. 

 

 Also remember to stop and start the application again in the 

System Manager. 
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PART 3:  

PARTICULARITIES ABOUT THE 

CONNECTORS 

Even though the basic configuration is common for all IRISConnect 

connectors, there are still some particularities to be taken into 

account.  

These particularities are discussed for the ECM systems Therefore, 

SharePoint, FileNet and IRISNext. 

The Cloud systems Box, Dropbox, Evernote and GoogleDocs are 

bundled in one license package called IRISConnect for Cloud. 

Their particularities are discussed jointly in the section Cloud 

systems. 

ODBC and Toolbox are discussed in separate Technical Notes. 

THEREFORE 

THEREFORE FEATURES 

IRISConnect is compatible with Therefore 2010 RD 2 and higher. 

IRISConnect is also compatible with Therefore Online. 

In order to export to Therefore you need to have access to a valid 

Therefore Server and have a Therefore Client installed and 
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configured on your computer. Note that the Therefore Client must 

be compatible with the Therefore server you want to connect to. 

Export to Therefore via the IRISPowerscan Configuration 

Wizard 

In case of a quick, basic configuration through the Configuration 

Wizard all the documents you process are exported to the same 

Therefore server and as the same document Category. 

 Enter the address of your Therefore Server. 

 Enter your Username and Password. 

 The Tenant field is only required if you are using Therefore 

Online. 

Therefore Online is a multi-tenant – or multi-owner – 

system, in which each tenant has his own server. 

 Then click Connect to establish the connection. 

 Finally select to which Therefore Category you want to export 

documents. 

The categories that are available on the server you 

connected to are displayed in the list. 
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EXPORT TO THEREFORE VIA THE IRISCONNECT 

INTERFACE 

When you are exporting documents via the IRISConnect interface, 

you can export documents to multiple Therefore servers at the same 

time, and export documents as different Categories at the same 

time. 

The only thing that differs in terms of configuration in the 

IRISConnect interface, is that you don’t have a Category to select 

when doing Step 1; Establishing the connection. 

Selecting a category is done during Step 3; Creating Rules. 



Part 3:Particularities about the Connectors 

86 

 

 

SHAREPOINT 

SHAREPOINT FEATURES 

IRISConnect is compatible with Microsoft SharePoint 2007 and 

higher. 

IRISConnect is also compatible with Microsoft SharePoint online. 

In order to export to SharePoint you need to have access to a valid 

SharePoint Server. 

EXPORT TO SHAREPOINT VIA THE 

IRISPOWERSCAN CONFIGURATION WIZARD 

In case of a quick, basic configuration through the Configuration 

Wizard all the documents you process are exported to the same 

SharePoint Server, Database and Document Category. 
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 Enter the address of your SharePoint server. 

 Enter your Username and Password. 

This is optional and depends on your SharePoint server. 

 Click Connect to establish the connection. 

 When the connection is successful, the Database list becomes 

available.  

 Select the Database to which you want to export your 

documents. 

Only the databases that are available in your SharePoint 

system are listed. 

 Browse for the exact Folder to which you want to export your 

documents. 

 In the Category list, select Folder or Document. Your 

documents can either be exported as folders or documents. 
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EXPORT TO SHAREPOINT VIA THE IRISCONNECT 

INTERFACE 

If you want to export different document types to different 

SharePoint servers, then continue with an advanced configuration 

via the IRISConnect interface. In this case, you can also export 

documents to folders that do not exist yet and create them at the 

same time. 

First access the IRISConnect interface, then go through the 

following steps: 

Step 1: Establish the connection 

 Click the down arrow right of the green cross  and click 

Connection. 

 Enter a name for your connection. 

 Enter the URL in the Server field. 

 Enter your Username and Password.  

This is optional and depends on your SharePoint server. 

 Click Connect to establish the connection. 

If the connection was successful, the "not connected" warning 

disappears. 

 Then select the Database to connect to and click Connect again. 

Again, if the connection was successful, the "not connected" 

warning disappears. 
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Steps 2 and 3: Define the rule sets and rules  

When exporting to SharePoint multiple export scenarios are 

possible. You can for instance export your documents to an existing 

folder on the SharePoint server, or create a new folder and 

simultaneously export your document to the newly created folder. 

You can do this by creating specific rules. 

Export scenarios 

1. Export your documents to an existing folder 

 In this case you can use a default Rule Set. 

 Then add a Rule to specify the exact folder to which the 

documents must be exported. 



Part 3:Particularities about the Connectors 

90 

  

 

 Browse for the path of the folder. 

 Select how the exported document will be named. Note that the 

content of index fields can be used as document name. 

 

 Select an Anchor in case you want to export your documents to 

a fixed object in SharePoint. 

 Then, select Document as Object type. 
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2. Create a new folder and export your documents to that folder 

When you want to create a new folder on your SharePoint server 

and export your documents simultaneously to that new folder, you 

need to create 2 rules: 1 that applies to the folder and 1 that applies 

to the documents. 

 In this case you can use a default Rule Set. 

 Then, add the first rule to create a folder: 

o Click Browse to select in which location you want to 

create a folder.  

o Select folder as Object type. 

o Click OK to return to the IRISConnect main screen. 

 Then, add a second rule to export your documents to the new 

folder: 

o On the Generalities tab, leave the Path field empty. This 

way, IRISConnect uses the path you defined in the 

previous rule. 

o Select Document as Object type. 

 Click OK to finish the configuration. 

IRISNEXT 

IRISNEXT FEATURES 

IRISConnect is compatible with IRISNext 7.2 and higher. 
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In order to export to IRISNext you need to have access to a valid 

IRISNext Server.  

IRISNext is an ECM system with a strict object hierarchy. Make 

sure you are aware of the hierarchy that is used in your IRISNext 

system. After all, the same structure must be respected when 

configuring IRISConnect. 

EXPORT TO IRISNEXT VIA THE 

IRISPOWERSCAN CONFIGURATION WIZARD 

In case of a quick, basic configuration through the Configuration 

Wizard all the documents you process are exported to the same 

server, database, folder and category. 

 Enter the address of your IRISNext server. 

 Enter your Username and Password. 

 Then click Connect to establish the connection. 

 Select the Database to which you want to export documents. 

 If required, select the subfolder of the database to which the 

documents must be exported. 

 Then select as which Category the documents must be exported. 
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 Click Next if you want to go to step 2. The next steps are the 

same for all the connectors and are discussed in Part 2 > 

IRISPowerscan > Configuration Wizards. 

EXPORT TO IRISNEXT VIA THE IRISCONNECT 

INTERFACE 

If you want to export different document types to different 

IRISNext servers, then continue with an advanced configuration via 

the IRISConnect interface. In this case, you can also export 

documents to folders that do not exist yet and create them at the 

same time. 

First access the IRISConnect interface, then go through the 

following steps: 

file:///C:/Documentation/irisconnect%20v5.8%20sharepoint/irisconnect/html/configuration_wizards.htm
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Step 1: Establish the connection 

 Click the down arrow right of the green cross  and click 

Connection. 

 

 Enter a name for your connection. 

 Enter the URL in the Server field. 

 Enter your Username and Password.  

 Select the language of your system. 

 Click Connect to establish the connection. 

If the connection was successful, the "not connected" warning 

disappears. 

 Select a Database inside IRISNext, then click Connect again. 

The "not connected" warning disappears if the connection was 

successful. 
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Steps 2 and 3: Define the rule sets and rules  

When exporting to IRISNext multiple export scenarios are possible. 

You can for instance export documents to a cabinet in which there 

aren't any folders yet. In that case, you must configure a rule that 

creates a folder inside the cabinet, and another rule that exports your 

documents to that folder. 

Export scenario: create a new folder inside a cabinet and export 

your documents to that folder 

 In this case you can use a default Rule Set. 

 Then, add the first rule to create a folder:  

o Click Browse to select in which Cabinet you want to 

create a folder.  

o Do not select an Anchor. 
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o Select Folder as Object type. 

o Determine the Access Control. 

These settings determine users’ access rights to the 

exported object. 

o Determine the Retention Definition. 

These settings determine how long the object will be 

stored. 

For more information about the latter two options, refer to 

the IRISNext Documentation. 

 

o Click OK to return to the IRISConnect main screen. 

 Then add a second rule to export your documents to the new 

folder: 
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o On the Generalities tab, leave the Path field empty. This 

way, IRISConnect uses the path you defined in the 

previous rule. 

o Select document as Object type. 

o Click OK to finish the configuration. 

 

Important notes: 

If you used the IRISPowerscan Configuration Wizard, your 

IRISPowerscan indexes have been mapped to your IRISNext 

indexes. To check the mapping, click the Fields tab within a rule 

configuration. Depending on the object type you selected, the 

corresponding IRISNext indexes are displayed.  

If necessary, you can modify them. To do so, right-click an 

IRISNext index (label), and select which other IRISPowerscan 

index you want to map it to. 
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FILENET 

FILENET FEATURES 

IRISConnect is compatible with FileNet P8 and higher. 

In order to export to FileNet you need to have access to a valid 

FileNet Server. 

In addition, Microsoft Web Services Enhancements 3.0 must be 

installed. To install it, run wse30.msi in the Tools folder of the 

IRISConnect cd-rom. 

EXPORT TO FILENET VIA THE IRISPOWERSCAN 

CONFIGURATION WIZARD 

In case of a quick, basic configuration through the Configuration 

Wizard, all the documents you process are exported to the same 

server, database, folder, category and object class. 

 Enter the address of the FileNet server. 

 Enter your User name and Password. 

 Then click Connect to establish the connection. 

 Select the Database to which you want to export documents. 

 If required, select the subfolder of the database to which the 

documents must be exported. 

 Then select as which Category the documents must be exported. 

 Finally select the Object class. 
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 Click Next if you want to go to step 2 of the wizard. The next 

steps are the same for all connectors and are discussed in Part 2 

> IRISPowerscan > Configuration Wizards. 

EXPORT TO FILENET VIA THE IRISCONNECT 

INTERFACE 

If you want to export different document types to different 

IRISNext servers or subfolders, then continue with an advanced 

configuration via the IRISConnect interface. In this case, you can 

also export documents to folders that do not exist yet and create 

them at the same time. 

First access the IRISConnect interface, then go through the 

following steps: 

file:///C:/Documentation/irisconnect%20v5.6%20-%20bad/irisconnect/html/configuration_wizards.htm
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Step 1: Establish the connection 

 Click the down arrow right of the green cross and click 

Connection. 

 

 Enter a name for your connection. 

 Enter the URL in the Server field. 

 Then enter your Username and Password. 

 Click Connect to establish the connection. 

If the connection was successful, the "not connected" warning 

disappears. 

 Then select the Database to connect to and click Connect again. 

Again, if the connection was successful, the "not connected" warning 

disappears. 
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Steps 2 and 3: Define the rule sets and rules 

When exporting to FileNet multiple export scenarios are possible. 

You can for instance export your documents to an existing folder or 

create a new folder inside a FileNet database and export your 

documents to that folder. You can do this by creating specific rules. 

Export scenarios 

1. Export your documents to an existing folder 

 In this case you can use a default Rule Set. 

 Then add a Rule to specify the exact folder to which the 

documents must be exported. 
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 Click Browse to select to which folder you want to export 

documents..  

 Do not select an Anchor. 

 Select document as Object type. 

 Also select document as Object class. 

 

2. Create a new folder and export your documents to that folder 

When you want to create a new folder inside a FileNet database and 

export your documents simultaneously to that new folder, you need 

to create 2 rules: 1 rule that applies to the folder, and 1 rule that 

applies to the documents. 
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 In this case you can still use a default Rule Set. 

 Then, add the first rule to create a folder: 

o Click Browse to select in which location you want to 

create a folder.  

o Select folder as Object type. 

o Also select folder as Object class. 

 

o Click OK to return to the IRISConnect main screen.  

 

 Then, add a second rule to export your documents to the new 

folder: 

o On the Generalities tab, leave the Path field empty. This 

way, IRISConnect uses the path you defined in the 

previous rule. 

o Select document as Object type. 

o Then select as what kind of the document you want export 

them in the Object class field. 

o Click OK to finish the configuration. 
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Important Notes 

If you used the IRISPowerscan Configuration Wizard, your 

IRISPowerscan indexes have been mapped to your FileNet indexes. 

To check the mapping, click the Fields tab within a rule 

configuration. Depending on the object class you selected, the 

corresponding FileNet indexes are displayed.  

If necessary, you can modify them. To do so, right-click an FileNet 

index (label), and select which other IRISPowerscan index you 

want to map it to. 

 

CMIS 

IRISConnect is compatible with CMIS 1.0 and higher. More 

information about CMIS will be available in a separate Technical 

Note. 
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CLOUD SYSTEMS 

IRISConnect is compatible with the Cloud systems Box, Dropbox, 

Evernote and GoogleDocs. 

EXPORT TO THE CLOUD VIA THE 

IRISPOWERSCAN CONFIGURATION WIZARD 

In case of a quick, basic configuration through the Configuration 

Wizard all the documents you process are exported to the same 

account and to the same folder. 

 Enter your username and password. 

 If necessary, indicate to which folder your documents must be 

exported. 
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 Click Next if you want to go to step 2 of the wizard. The next 

steps are the same for all connectors and are discussed in Part 2 

> IRISPowerscan > Configuration Wizards. 

Important note about Step 2 of the Wizard: when connecting 

to the Cloud systems mentioned above you will not see any 

documents fields in step 2 Define document fields. The reason 

for this is the fact that these Cloud systems do not commonly use 

an indexing system. As a result, any indexes you apply in 

IRISPowerscan will not be exported to your Cloud systems.  

EXPORT TO THE CLOUD VIA THE IRISCONNECT 

INTERFACE 

If you want to export different document types to different folders, 

or to different collections in the case of Evernote and GoogleDocs, 

then continue with an advanced configuration via the IRISConnect 

interface. In this case, you can also export documents to folders that 

do not exist yet and create them at the same time. 

First access the IRISConnect interface, then go through the 

following steps: 

Step 1: Establish the connection 

 Click the down arrow right of the green cross and click 

Connection. 

file:///C:/Documentation/irisconnect%20v5.6%20-%20bad/irisconnect/html/configuration_wizards.htm
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 Enter a name for your connection. 

 Then enter your Username and Password. 

 Click Connect to establish the connection. 

If the connection was successful, the "not connected" warning 

disappears. 

 

Steps 2 and 3: Define the rule sets and rules 

When exporting to the Cloud multiple export scenarios are possible. 

You can for instance export your documents to an existing folder or 

create a new folder/collection in your account and export your 

documents to that folder/collection. You can do this by creating 

specific rules. 

Export scenarios 

1. Export your documents to an existing folder/collection 

 In this case you can use a default Rule Set. 

 Then add a Rule to specify the exact folder to which the 

documents must be exported. 
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 Click Browse to select to which folder you want to export 

documents. 

 Select document as Object type. 

 

 

2. Create a new folder and export your documents to that 

folder/collection 

When you want to create a new folder/collection inside a Cloud 

account and export your documents simultaneously to that new 

folder, you need to create 2 rules: 1 rule that applies to the 

folder/collection, and 1 rule that applies to the documents. 

 In this case you can still use a default Rule Set. 

 Then, add the first rule to create a folder/collection: 

o Click Browse to select in which location you want to 

create a folder.  

o Select folder/collection as Object type. 
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o Click OK to return to the IRISConnect main screen.  

 Then, add a second rule to export your documents to the new 

folder/collection: 

o On the Generalities tab, leave the Path field empty. This 

way, IRISConnect uses the path you defined in the 

previous rule. 

o Select document as Object type. 

o Then select as what kind of the document you want export 

them in the Object class field. 

o Click OK to finish the configuration. 
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